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The CY8CKIT-044 PSoC® 4200M Pioneer Kit is intended for use as a development platform for hardware or software in a
laboratory environment. The board is an open system design, which does not include a Shielded enclosure. For this reason,
the board may cause interference with other electrical or electronic devices in close proximity. In a domestic environment,
this product may cause radio interference. In such cases, the user may be required to take adequate preventive measures.
Also, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable
mitigating measures should be taken.

The CY8CKIT-044 as shipped from the factory has been verified to meet with the requirements of CE as a Class A product.

The CYB8CKIT-044 board contains electrostatic discharge (ESD) sensitive devices.
Electrostatic charges readily accumulate on the human body and any equipment which
‘ can cause a discharge without detection. Permanent damage may occur to devices
subjected to high-energy discharges. Proper ESD precautions are recommended to avoid

performance degradation or loss of functionality. Store unused CY8CKIT-044 boards in the
protective shipping package.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of manufacture mentioned on
the back of the box. Contact the nearest recycler to discard the kit.

General Safety Instructions
ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an
ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap
attached to a grounded metal object.

Handling Boards

CY8CKIT-044 board is sensitive to ESD. Hold the board only by its edges. After removing the board from its box, place it on
a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over any surface.

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A 6
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Thank you for your interest in the CY8CKIT-044 PSoC® 4 M-Series Pioneer Kit. The PSoC 4 M-Series Pioneer Kit enables
customers to evaluate and develop projects using the PSoC 4200M device family.

PSoC 4200M device family is an expansion to the PSoC 4 device family that offers more flash, GPIOs, and programmable
analog and digital blocks. PSoC 4200M device is a true programmable embedded system-on chip, integrating custom
analog and digital peripheral functions, memory, and an ARM® Cortex®-MO0 microcontroller on a single chip. The
programmable analog and digital peripheral functions allow higher flexibility, in-field tuning of the design, and faster time-to-
market.

The PSoC 4 M-Series Pioneer Kit offers footprint-compatibility with ArdumoTM Shields, 6-pin Dlgllent Pmod™ Peripheral
Modules, and Raspberry Pi boards. This kit features two CapSense® Proximity headers, a CapSense Gesture Pad, an
ambient light sensor, a 3-Axis accelerometer, a PWM temperature sensor, an RGB LED, a push button switch, an onboard
programmer/debugger and USB-UART/I2C bridge functionality block (KitProg), and a Cypress F-RAM™. This kit supports
operating voltages of 3.3V or5 V.

You will use PSoC Creator™ to develop and debug your PSoC 4200M device projects. PSoC Creator is Cypress’ standard
integrated design environment (IDE). If you are new to PSoC Creator, see the documentation on the PSoC Creator home
page. You can also refer the application note AN79953 — Getting Started with PSoC 4, which gives an introduction to the
PSoC 4 device.

1.1 Kit Contents

The CY8CKIT-044 PSoC 4 M-Series Pioneer Kit contains the following, as shown in Figure 1-1.
B PSoC 4 M-Series Pioneer board

®  USB Standard-A to Mini-B cable

B Four jumper wires (4 inches each)

B Two proximity sensor wires (5 inches each)

®  Micrium® uC/Probe™ license card

B Quick Start Guide

Note: The Micrium uC/Probe license is valid only for one month from the date of activation.

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A 7
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Introduction
Figure 1-1. Kit Contents

044 QUICK START GUIDE

PSOC® 4 M-SERIES PIONEER KIT

Kit Contents:

W
1 PSoC® 4 MSeries Pioneer board J W W
2 USB StondardA fo MiniB cable EI%EEE . i wo s <
3 Four jumper wires (4 inches each) P AN

4 Two proximity sensor wires (5 inches each) Eh 2

5 Micrium’s pC/Probe license card
6 Quick Start Guide (this document)

Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office for help:
WWW.cypress.com/go/support.

1.2 Board Detalils

The PSoC 4 M-Series Pioneer Kit consists of the following blocks, as shown in Figure 1-2. It also shows the complete kit
headers pin mapping.
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Figure 1-2. PSoC 4 M-Series Pioneer Kit Markup

23 13 22 21 20

1 Power and Status LED

19 |2 USB connector yé)

16 |3 System power supply jumper (J9) and
LDO (3.3V)

4 PSoC 5LP programmer and debugger
18 (CY8C5868LTI-LPO39)

PSoC 5LP I/O header (18)
17 PSoC 4200M (CY8C4247AZI-M485)

16 |7 PSoC 4200M program and
debug header (J13)

15
14 8 Digilent® Pmod™ compatible 1/O
header (J16)
8 0 10: 11 12 13 9 PSoC 4200M reset button
10 Arduino™ compatible power header (J1)
11 RGB LED
oxSna—o 12 User button
g§§§§§g§g§ gggggggg 13 Arduino compatible I/O headers
2-Goedeios ol oogn (12/13/14)

14 Raspberry Pi compatible header (J15)
15 3-Axis Accelerometer
16 CapSense Proximity headers (J10/J11)

o
Iw
~N

:g—g 17 PSoC 4200M current measurement
PO_6 i

pe jumper (J14)

Eﬁ‘g 18 CapSense Gesture Pad

GND

19 PWM Temperature Sensor

20 Cypress FRAM 1 Mb (FM24V10-G)

21 Ambient Light Sensor

22 32.768 kHz crystal

23 PSoC 5LP program and debug header (J5)

oocn—ow QEMO0QZ O—aMTNO~N

0Z o'o'oo D%«iu—iZZZ D ey A e | 2

{Qn.n.gg > Do SNRINNDO0 B Arduino Uno R3
OxSosy IERZNAZ oS38SS ot :
3%898‘/’ $EZ;Z%> 222232 B PSoC 4 M-Series Pioneer Kit
0722 %L&"". e B Digilent Pmod
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1.3 PSoC Creator

PSoC Creator is a state-of-the-art, easy-to-use IDE. It introduces revolutionary hardware and software codesign, powered
by a library of preverified and precharacterized PSoC Components™, as shown in Figure 1-3. With PSoC Creator, you can:

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler

Drag and drop Components to build your hardware system design in the main design workspace

Codesign your application firmware with the PSoC hardware

Configure Components using configuration tools

Explore the library of 100+ Components

Access Component datasheets

Figure 1-3. PSoC Creator Features

Introduction

Eile Edit View Project Build Debug Iools
A Ga@ X |9 o
B-o5 2 88 & _ Microsoft Sans Serif

Fal=A" N =11

‘Workspace Explorer (1 project) ~ % %
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=] of

I
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0. Reference resistor

Search for.
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Cypress | Off-Chip ab
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: : % UART (SCB mode) [v1.10
Host Processor Interface | Configure ‘FanController TN 7 s 9 von & ﬁUART Evz 0 )v1.10]
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Name:  FanCortroler_1 "
@8 Functions
. Basic/ Fans | Buitin - &9 Logic
= % Registers
Motor support PWM output corfiguration &8 Utility
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General Description
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e and o

Errors 0 Warnings 1 Notes

programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator.
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1.3.1 PSoC Creator Code Examples

PSoC Creator includes a large number of code example projects.
These projects are accessible from the PSoC Creator Start

Page, as shown in Figure 1-4.

Example projects can speed up your design process by starting
you off with a complete design, instead of a blank page. The
example projects also show how to use PSoC Creator
Components for various applications. Code examples and
documentation are included, as shown in Figure 1-5.

In the Find Example Project dialog shown in Figure 1-5, you

have several options:

m  Filter for examples based on device family or keyword.

m  Select from the list of examples offered based on the Filter

Options.

®  View the project documentation for the selection (on the

Documentation tab).

®  View the code for the selection. You can also copy and
paste code from this window to your project, which can help

speed up code development.

Introduction

Figure 1-4. Code Examples in PSoC Creator

=~ b3 "|| StartPageII

sjuaUodwor) | adunog

sjaaLseIeq

sqnsay

PSoC® Creator™

Recent Projects
[ CYBCKIT_044_Sensor_Hub.cywrc
[ CYBCKIT_044_Accelerometer.cywric
[ CYBCKIT_044_CapSense_Touch_Gestures.cywrk
E] CY8CKIT-044 cywr
] bootloader.cywrk

Create New Project...
Open Exsting Project...

Getting Started
PSoC Creator Start Page
Quick Start Guide
Intro to PSoC
Intro to PSoC Creator
PSoC Creator Training
Design Tutorials
Getting Started With PSoC 3
Getting Started With PSoC 4
Getting Started With PSoC 5LP
Getting Started with PSoC 4 BLE
Getting Started with PRoC BLE

Examples and Kits

Find Example Project

[ Kits

m  Create new workspace for the example project. This can speed up your design process by starting you off with a
complete, basic design. You can then adapt that design to your application.

Figure 1-5. Code Example Projects with Sample Code

I Filter Options I

Device Family: Al
Keyword: PSoC 3
PSoC 4000
Project Name: PSoC 4100
. P5oC4200
BLE_Extemal_Memory P5oC 4100 BLE
BLE_FindMe PSoC 4200 BLE

BLE_Glucose_Meter PRoC ELE
BLE_Heart_Rate_Colle PSoC 4100M
BLE_Heart_Rate_Sen: PSoC 4200M
BLE_HID_Keyboard PSoC 5LP

Documenmﬁon)/Sample Code .ﬂ] I

BLE_HID_Mouse

BLE_Phone_Alet

BLE_Proxdmity
BLE_Running_Speed_Cadence
BLE_Shared_Memary_Bootloadable
BLE_Shared_Memory_Bootloader
BLE_Temperature_Measurement
BLE_TimeSync

BoostExample
Bootloadable_PSoC4_Example
Bootloader_PSoC4 Example
CAM_BEasic_Example
CAM_Basic_P4_E<ample
CAM_Full_BExample
CAM_Full_P4_Example

nse CSD_Design

= SD P4 Design
Cap5 _CSD_P4_Example_WithTuner
CapSense_CSD_P4_LowPower
CapSense_CSD_P4_Proximity_Design
CapSense_CSD_P4_Trackpad_Gestures
CapSense_CSD_WithTuner
CharlCD_CustomFont

int main()

{
/% Enable global interr
CyGlobalIntEnable;
LED CONTRCL Start():

CapSense CSD Start():

f/* Initialize baselines

CapSense CS5D InitializeAllBaselines():

while (1u)
{

CapSense_C5D Update

/* Start scanning a

CapSense CS5D ScanEnabledWidgets():;

/% Wait for =cannin

while (Cap5ense_C5D

{
/* Loop until c

mn

upts */

m

EnabledBaselines () ;

g to complete */
I=Busy() '= 0)

ondition true */

3

Create New Workspace

| Cancel
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Introduction

1.3.2 Kit Example Projects

You can access the installed kit example projects from the PSoC Creator Start Page. To access these example projects,
expand the Kits under the section Examples and Kits; then, expand the specific kit to see the example projects. Refer to
the Using the Kit Example Projects section for a detailed explanation on how to access the kit example projects.

1.3.3 PSoC Creator Help

Launch PSoC Creator and navigate to the following items:

B Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you the basics for
developing PSoC Creator projects.

®  Simple Component example projects: Choose File> Open > Example Projects. These example projects
demonstrate how to configure and use PSoC Creator Components. To access example projects related to a specific
Component, place the Component on the TopDesign schematic and right-click on the Component. Select the Find
Example Project option in the context menu that appears.

m  Starter Designs: Choose File > New > Project and select PSoC 4100M / PSoC 4200M Starter Design. These starter
designs demonstrate the unique features of PSoC 4200M.

m  System Reference Guide: Choose Help > System Reference > System Reference Guide. This guide lists and
describes the system functions provided by PSoC Creator.

®  Component Datasheets: Right-click a Component and select Open Datasheet. Visit the PSoC 4 Component
Datasheets page for a list of all PSoC 4 Component datasheets.

®  Document Manager: PSoC Creator provides a document manager to help you easily find and access the document
resources. To open the document manager, choose the menu item Help > Document Manager.

1.4 Getting Started

This guide will help you be acquainted with the CY8CKIT-044 PSoC 4 M-Series Pioneer Kit:

B The Installation chapter describes the installation of the kit software. This includes the PSoC Creator IDE to develop
and debug the applications, and PSoC Programmer to program the .hex files on to the device.

B The Kit Operation chapter describes the major features of the PSoC 4 M-Series Pioneer Kit and functionalities such as
programming, debugging, and the USB-UART and USB-12C bridges.

B The Example Projects chapter describes multiple PSoC 4200M code examples that will help you understand how to
create your own PSoC 4 projects.

B The Appendix provides the method to use the Micrium pC/Probe tool, detailed hardware description, method to use the
onboard F-RAM, kit schematics, and the bill of materials (BOM).

1.5 Additional Learning Resources

Cypress provides a wealth of data at www.cypress.com to help you to select the right PSoC device for your design, and to
help you to quickly and effectively integrate the device into your design. For a comprehensive list of resources, see
KBA86521, How to Design with PSoC 3, PSoC 4, and PSoC 5LP. The following is an abbreviated list for PSoC 4:

®  Qverview: PSoC Portfolio and PSoC Roadmap.
B Product Selectors: PSoC 4 Product Selector. In addition, PSoC Creator includes a device selection tool.

®  Datasheets: Describe and provide electrical specifications for the PSoC 4000, PSoC 4100, PSoC 4200, PSoC 4100M,
and PSoC 4200M device families.

B CapSense Design Guide: Learn how to design capacitive touch-sensing applications with the PSoC 4 family of
devices.

m  Application Notes and Code Examples: Cover a broad range of topics, from basic to advanced. Many of the
application notes include code examples. Visit the PSoC 3/4/5 Code Examples webpage for a list of all available PSoC
Creator code examples. To access code examples from within PSoC Creator — see PSoC Creator Code Examples.

®  Technical Reference Manuals (TRM): Provide detailed descriptions of the architecture and registers in each PSoC 4
device family.
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®  Development Kits:

Introduction

[0 CY8CKIT-042 and CY8CKIT-040 are easy-to-use and inexpensive development platforms. These kits include
connectors for Arduino compatible Shields and Digilent Pmod Peripheral Modules.

[0 CYB8CKIT-049 is a very low-cost prototyping platform for sampling PSoC 4 devices.

[0 CYB8CKIT-001 is a common development platform for all PSoC family devices.

0 MiniProg3 device provides an interface for flash programming and debug.

® Knowledge Base Articles (KBA): Provide design and application tips from experts on using the device. For instance,
KBA93541 explains how to use CY8CKIT-049 to program another PSoC 4.

®  PSoC Creator Training: Visit www.cypress.com/go/creatorstart/creatortraining for a comprehensive list of video
trainings on PSoC Creator.

B Learning from Peers: Visit www.cypress.com/forums to meet enthusiastic PSoC developers discussing the next
generation embedded systems on Cypress Developer Community Forums.

1.6 Technical Support

For assistance, visit Cypress Support or contact customer support at +1(800) 541-4736 Ext. 2 (in the USA) or +1 (408) 943-

2600 Ext. 2 (International).

1.7 Document Conventions

Table 1-1. Document Conventions for Guides

Convention

Usage

Courier New

Displays file locations, user-entered text, and source code:
C:\ ...cd\icc\

Italics

Displays file names and reference documentation:

Read about the sourcefile..hex file in the PSoC Creator User Guide.

[Bracketed, Bold]

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open Represents menu paths:
File > Open > New Project
Bold Displays commands, menu paths, and icon names in procedures:

Click the File icon and then click Open.

Times New Roman

Displays an equation:
2+2=4

Text in gray boxes

Describes Cautions or unique functionality of the product.
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1.8 Acronyms

Table 1-2. Acronyms Used in this Document

Installation

Acronym Description
ADC Analog-to-Digital Converter
API Application Programming Interface
BOD Brown Out Detect
BOM Bill Of Materials
CAN Controller Area Network
COM Communication Port
DMA Direct Memory Access
ESD Electrostatic Discharge
F-RAM Ferroelectric Random Access Memory
GUI Graphical User Interface
GPIO General Purpose Input/Output
12C Inter-Integrated Circuit
IDE Integrated Development Environment
LCD Liquid Crystal Display
LDO Low Drop Out (voltage regulator)
LED Light-Emitting Diode
LP Low Power
LSB Least Significant Byte
LVD Low Voltage Detect
MSB Most Significant Byte
PSoC Programmable Systems-on-Chip
POR Power On Reset
PWM Pulse Width Modulation
RGB Red Green Blue
ROM Read Only Memory
SAR Successive Approximation Register
SCB Serial Communication Block
SPI Serial Peripheral Interface
SRAM Static Random Access Memory
SWD Serial Wire Debug
UART Universal Asynchronous Receiver Transmitter
ubB Universal Digital Block
usB Universal Serial Bus
WCO Watch Crystal Oscillator
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This chapter describes the steps to install the software tools and packages on a PC for using the CY8CKIT-044 PSoC 4 M-
Series Pioneer Kit. This includes the IDE on which the projects will be built and used for programming.

2.1 Before You Begin

To install Cypress software, you will require administrator privileges. However, they are not required to run software that is
already installed. Before you install the kit software, close any other Cypress software that is currently running.

2.2 Install Software
Follow these steps to install the CY8CKIT-044 PSoC 4 M-Series Pioneer Kit software:

1. Download the PSoC 4 M-Series Pioneer Kit software from www.cypress.com/CY8CKIT-044. The kit software is
available in three different formats for download.

a. CYB8CKIT-044 Kit Complete Setup: This installation package contains the files related to the kit. However, it
does not include the Windows Installer or Microsoft .NET framework packages. If these packages are not on
your computer, the installer directs you to download and install them from the Internet.

b. CY8CKIT-044 Kit Only: This executable file installs only the kit contents, which include kit code examples,
hardware files, and user documents. This package can be used if all the software prerequisites (listed in step
5) are installed on your PC.

c. CY8CKIT-044 DVD ISO: This file is a complete package, stored in a DVD-ROM image format, which you can
use to create a DVD or extract using an ISO extraction program such as WinZip® or WinRAR. The file can
also be mounted like a virtual CD/DVD using virtual drive programs such as Virtual CloneDrive and MagiclSO.
This file includes all the required software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it in a virtual drive. Extract the ISO contents if you do not have a virtual
drive to mount. Double-click cyautorun.exe in the root directory of the extracted content or the mounted I1SO if “Autorun
from CD/DVD” is not enabled on the PC. The installation window will appear automatically.

Note: If you are using the “Kit Complete Setup” or “Kit Only” file, then go to step 4 for installation.

3. Click Install CY8CKIT-044 to start the kit installation, as shown in Figure 2-1.
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Figure 2-1. Kit Installer Screen
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CYB8CKIT-044

Openthelqtuser(;mde

Install CYSCKIT-044

2014 Cypress Semiconductor Corporation. Al rights reserved

4. Select the folder in which you want to install the CY8CKIT-044 kit-related files. Choose the directory and click Next.
5.  When you click Next, the CY8CKIT-044 installer automatically installs the required software, if it is not present on your
computer. Following is the required software:
a. PSoC Creator 3.2 or later: This software is available separately from www.cypress.com/psoccreator.
b. PSoC Programmer 3.22.2 or later: This is installed as part of PSoC Creator installation or is available
separately from www.cypress.com/programmer.
6.

Choose the Typical/Custom/Complete installation type in the Product Installation Overview window, as shown in
Figure 2-2. Click Next after you select the installation type.
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Figure 2-2. Product Installation Overview
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7. Read the License agreement and select | accept the terms in the license agreement to continue with installation.
Click Next.

8. When the installation begins, a list of packages appears on the installation page. A green check mark appears next to
each package after successful installation.

9. Enter your contact information or select the check box Continue Without Contact Information. Click Finish to
complete the CY8CKIT-044 kit software installation.

10. After the installation is complete, the kit contents are available at the following location:

<Install Directory>\CY8CKIT-044 PSoC 4 M-Series Pioneer Kit
Default location:
Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-044 PSoC 4 M-Series Pioneer Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-044 PSoC 4 M-Series Pioneer Kit

Note: For Windows 7/8/8.1 users, the installed files and the folder are read only. To use the installed example projects,
follow the steps outlined in the Example Projects chapter.

2.3 Uninstall Software
The software can be uninstalled using one of the following methods:

®  Go to Start > All Programs > Cypress > Cypress Update Manager and select the Uninstall button that corresponds
to the kit software.

®  Go to Start > Control Panel > Programs and Features for Windows 7 or Add/Remove Programs for Windows XP;
select the Uninstall/Change button.

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A 17



3. Kit Operation
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The PSoC 4 M-Series Pioneer Kit is built around the PSoC 4200M device. Figure 3-1 shows the block diagram of the
PSoC 4200M device. Refer to the PSoC 4200M datasheet for details on device features.

Figure 3-1. PSoC 4200M Block Diagram
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Figure 3-2 shows the block diagram for the PSoC 4 M-Series Pioneer Kit.
Figure 3-2. Block Diagram of PSoC 4 M-Series Pioneer Kit

PSoC 4200M Arduino Compatible Input/Output Headers |

A A
» F-RAM Ambient PWM Proximity
Light Temp
10-pin | 32kHz Sensor Sensor Gesture Pad
Debug Crystal
Status LED v 4 Q
Ee—— Y |-> D
Y USB-12C ;|
USB ) (USB-UART, | < <>
Mini-B [€ » KitProg |, swbD > PSoC 4200M
Reset > <
4 | Level
27 = 7| Translator
KitProg /0 | r L‘ A Proximity
Header [ y ]
10-pin )
Debug *.: . :.: Pl 3-Axis
Reset Button A RGB LED Push Button Accelerometer
PSoC 4200M Arduino Compatible Input/Output Headers
\ 4
Digilent Pmod Compatible Header }(J | Rapsberry Pi Compatible Header

Figure 3-3. PSoC 4 M-Series Pioneer Kit Board Diagram
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Kit Operation

This kit has the following peripherals:

1.

10.

11.
12.

13.

14.

15.

16.

17.

18.

Power and Status LED: The amber power LED is turned on when the kit is connected to a power source. The green
status LED indicates the status of the KitProg.

USB Mini-B connector: The USB cable provided along with the PSoC 4 M-Series Pioneer Kit connects between this
connector and the PC.

Power Supply: The kit can operate at two voltage levels, 3.3 V and 5 V. The power selection jumper J9 is used to select
between the two voltage levels. The kit has an onboard 3.3-V Low Drop Out (LDO) regulator that converts the 5-V input
t0 3.3 V.

KitProg: The KitProg is a multi-functional system, which includes a programmer, debugger, USB-I12C bridge, and a
USB-UART bridge. Refer to the KitProg User Guide in the installation folder <Install Directory>\CY8CKIT-044
PSoC 4 M-Series Pioneer Kit\<version>\Documentation\KitProg User Guide.pdf for more details
on the KitProg.

KitProg (PSoC 5LP) I/0 Header: This header brings out a few Input/Output lines of the onboard PSoC 5LP device. This
includes the KitProg USB-I2C bridge lines and USB-UART bridge lines. The additional PSoC 5LP pins are direct
connections to the internal programmable analog logic of PSoC 5LP. You can use these pins as General-purpose
input/output (GPIO) also. For more details on the KitProg functionality, refer to the KitProg User Guide.

PSoC 4200M: This kit is designed to highlight the features of PSoC 4200M.

10-pin programming header for PSoC 4200M: This header allows you to program/debug the PSoC 4200M using an
external programmer such as MiniProg3. PSoC 4 M-Series Pioneer Kit also has through-hole test points to allow you to
program and debug external PSoC 4 and PSoC 5LP devices using the KitProg. You must remove the zero-ohm
resistors R51, R53, and R55 to disconnect the connection between KitProg and the onboard PSoC 4200M device
before programming an external PSoC.

Digilent Pmod Peripheral Module compatible header: This header allows you to connect to the PSoC 4200 device to
Pmod Peripheral Modules though 12C and SPI interfaces.

Reset Button: This button is used to reset the PSoC 4200M device.

Arduino Uno Shield compatible power header: This header powers third-party party Arduino Shields. This header also
has a provision to power the PSoC 4 M-Series Pioneer Kit though the VIN input on the header.

RGB LED: The onboard RGB LED can be controlled from the PSoC 4200M device.

User Button: This button can be used to provide input to the PSoC 4200M. Note that the switch connects the PSoC
4200M pin to ground when pressed, so you need to configure the PSoC 4200M pin as resistive pull-up for detecting the
switch press.

Arduino Uno Shield compatible /0O headers: The PSoC 4 M-Series Pioneer Kit is compatible and operates flawlessly
with third-party Arduino Shields.

Raspberry Pi compatible header: A header which is compatible with Raspberry Pi Model B is included on the kit for
enabling advanced embedded systems. A Raspberry Pi can communicate to the PSoC 4200M device using 12C, SPI,
or UART communication protocols. One of the applications of this header is to enable the PSoC 4200M to act as an
analog input processor for Raspberry Pi. The PSoC 4200M, with its CapSense capability, can also enable user
interface functions such as gesture and proximity detection.

3-Axis  Accelerometer: This kit features a 3-Axis digital accelerometer device from Kionix®
(KXTJ2-1009). The accelerometer is interfaced to the PSoC 4200M using the 12C protocol.

CapSense Proximity Headers: These headers are located on both sides of the CapSense Gesture Pad. They can be
used as individual proximity sensors or can be used together to detect CapSense proximity gestures. The example
project included with this kit demonstrates the detection of wave up and wave down proximity gestures. Remember to
connect wires into the proximity headers before using the proximity functionality. Note that if these inputs are not used
for proximity sensing, then the connectors and the associated 1/0Os are available for general-purpose use.

Current Measurement Jumper: This jumper can be used to measure the current consumed by the PSoC 4200M device
by connecting an ammeter between the pins 3 and 4 of the jumper. Remember to connect the jumper between pin 3
and pin 4 if the current measurement functionality is not used.

CapSense Gesture Pad: The CapSense Gesture Pad is a five-element CapSense peripheral specifically intended for
touch gesture recognition. This peripheral can be used to detect swipe left, swipe right, swipe up, swipe down,
clockwise swipe, and counter-clockwise swipe gestures.

Note: The Gesture Pad can also be used as five individual capacitive touch buttons. The Gesture Pad is not intended
to be used as a radial slider.
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19. PWM Temperature Sensor: The kit features a digital temperature sensor from Analog Devices (TMPO05). This sensor
measures the ambient temperature and reports it to the PSoC 4200M device by varying duty cycle of the PWM output
generated by the sensor.

E-RAM: This kit features a Cypress F-RAM device of 1 Mb capacity. The F-RAM is connected to the 12C interface of the
PSoC 4200M device. The Cypress F-RAM device can be used similar to an external EEPROM memory for data logging
operations. The F-RAM can also be used for bootloading the PSoC 4200M device.

21. Ambient Light Sensor: This is a photodiode connected in photoconductive mode to detect variations in the ambient light
intensity. The conductivity of this sensor increases when the ambient light intensity increases and results in a higher
current flow through the sensor. The PSoC 4200M internal opamps are used to implement a current to voltage
converter to detect these current variations. The resultant output voltage is measured using the internal SAR ADC of
the PSoC 4200M device to determine the ambient light intensity. Refer to the TEMD6200FX01 datasheet from Vishay®
Semiconductors for more information on the electrical characteristics of the sensor.

22. 32-kHz Crystal Oscillator: The PSoC 4 M-Series Pioneer Kit has a 32-kHz crystal oscillator to provide an accurate low-
frequency clock for the 4200M device.

23. 10-pin programming header for PSoC 5LP: This header is used to program/debug the PSoC 5LP using an external
programmer such as MiniProg3.

20.

o

The subsequent sections explain the method to interface the PSoC 4 M-Series Pioneer Kit to a PC.

3.2 KitProg

The KitProg is a multi-functional system, which includes a programmer, debugger, USB-I12C bridge, and a USB-UART
bridge. The Cypress PSoC 5LP device is used to implement KitProg functionality. The KitProg is integrated in most PSoC
development kits. For more details on the KitProg functionality, refer to the KitProg User Guide in the kit installation
directory: <Install Directory>\CY8CKIT-044 PSoC 4 M-Series Pioneer Kit\<version>\Documentation\
KitProg User Guide.pdf.

3.3 Programming and Debugging PSoC 4200M Device

The PSoC 4 M-Series Pioneer Kit can be programmed and debugged using the KitProg. Before programming the device,
ensure that PSoC Creator and PSoC Programmer software are installed on the PC. See the Install Software section for
more information.

3.3.1 Programming using PSoC Creator

1. Connect the USB cable into the USB connector, J6, as shown in Figure 3-4. The kit enumerates as a composite device
if you are plugging in the PSoC 4 M-Series Pioneer Kit to your PC for the first time.

Figure 3-4. Connect USB Cable to J6
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2. Open the desired project in PSoC Creator. For this, go to File > Open > Project/Workspace. This provides the option
to browse to and open your saved project.

3. Select the option Build > Build Project or pressing [Shift] [F6] to build the project.

4. |If there are no errors during build, program the firmware into the kit by choosing Debug > Program or pressing [Ctrl]
[F5]. This programs the device on the PSoC 4 M-Series Pioneer Kit.

3.3.2 Debugging using PSoC Creator

PSoC Creator has an integrated debugger. You can start the debugger by selecting Debug > Debug or by pressing [F5].
Refer to section 3.2 of the KitProg User Guide for a detailed explanation on how to debug using PSoC Creator.

3.3.3 Programming using PSoC Programmer

PSoC Programmer (3.22.2 or later) can be used to program existing .hex files into the PSoC 4 M-Series Pioneer Kit. Refer
to section 3.3 of the KitProg User Guide for a detailed explanation on how to program using PSoC Programmer.

3.4 USB-UART Bridge

The KitProg on the PSoC 4 M-Series Pioneer Kit can act as a USB-UART bridge. The UART lines between the PSoC
4200M and the KitProg are hard-wired on the board, with UART_RX assigned to P7[0] and UART_TX assigned to P7[1] on
PSoC 4200M. For more details on the KitProg USB-UART functionality, refer to the KitProg User Guide.

3.5 USB-I2C Bridge

The KitProg can function as a USB-I2C bridge and communicate with the software utility Bridge Control Panel (BCP). The
I2C lines on PSoC 4200M device are P4[1] (SDA) and P4[0] (SCL), which are hardwired on the board to the I2C lines of
the KitProg. The USB-12C supports 12C speeds of 50 kHz, 100 kHz, 400 kHz, and 1 MHz. For more details on the KitProg
USB-I2C functionality, refer to the KitProg User Guide.

3.6 Updating the KitProg Firmware

The KitProg firmware normally does not require any update. You can use the PSoC Programmer software to update the
KitProg firmware. Refer to the KitProg User Guide for a detailed explanation on how to update the KitProg firmware.
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The CY8CKIT-044 PSoC 4 M-Series Pioneer Kit includes six example projects. This chapter explains how to use these
example projects.

4.1 Using the Kit Example Projects

To access the example projects, download and install the CY8CKIT-044 PSoC 4 M-Series Pioneer Kit setup file from the kit
web page. After installation, the example projects are available in the “Firmware” folder in the installation directory.

Follow these steps to open and use the example projects.
1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator <version> > PSoC.
2. Creator <version>

3. On the Start page, click CY8CKIT-044 under Examples and Kits > Kits. A list of example projects appears, as shown
in Figure 4-1.

4. Click on the desired example project, select a location to save the project and click OK.

Figure 4-1. Open Example Project from PSoC Creator

| Workspace Explorer (0 projects) T %l start Page
5
Noworkspace open PSOC® creator"'l

Getting Started
PSoC Creator Start Page
Quick Start Guide
Intro to PSoC
Intro to PSoC Creator
PSoC Creator Training
Design Tutorials
Getting Started With PSoC 3
Getting Started With PSoC 4
Getting Started With PSoC 5LP
Getting Started with PSoC 4 BLE
Getting Started with PRoC BLE

ls:unsaa/[ sqaaqqupq/[squauodmo:)/l a%unos

Examples and Kits
Find Example Project...
= Kits
CYBCKIT-D0SA 2.1
CYBCKIT-017 CAN/LIN Expansion Board Kit 2.0
CYBCKIT-040
CYBCKIT-D42
= CYBCKIT-044
ET] CYBCKIT_044_Accelerometer.cywrk
] CYSCKIT_044_CapSense_Proximity cywrk
ET] CYBCKIT_044_Deep_Sleep_Blinky.cywrk
E] CYBCKIT_044_Proximity_Gestures. .cywrk
ET] CYBCKIT_044_Sensor_Hub .cywrk
Ef] CYBCKIT_044_Touch_Gestures.cywrk
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Build the example project by choosing Build > Build <Project Name>. A .hex file is generated after the build process.

Connect the PSoC 4 M-Series Pioneer Kit to the PC using the USB cable connected to connector J6 as shown in

Figure 3-4, to program the kit with this example project.

Choose Debug > Program in PSoC Creator.

If the device is already acquired, programming will complete automatically — the result will appear in the PSoC Creator
status bar at the bottom left side of the screen. If the device is yet to be acquired, the Select Debug Target window wiill

appear. Select KitProg/<serial number> and click the Port Acquire button, as shown in Figure 4-2.

Figure 4-2. Port Acquire

| KitProg/171D0E3602213400

[7 ==

POWER =3
VOLTAGE_ADC = 3445
FREQUENCY = 2000000
PROTOCOL = SWD

KitProg Version 2.10

Show all targets - |

| Part Setting | I Port Acquire I

I

4]

After the device is acquired, it is shown in a tree structure below the KitProg/<serial number>. Click the Connect
button and then OK to exit the window and start programming, as shown in Figure 4-3.

Figure 4-3. Connect Device From PSoC Creator and Program

5 KitProg/171D0E3602213400
* PSoC 4200M CYBC4247AZI-M485

Show all targets -

(7=

PSoC 4200M CYBCA4247AZ1-M485

E PSoC 4200M (ARM CMO)
Silicon 1D: Bx0BE11477

Cypress 1D: (x112011A1
Revision: PRODUCTION

Target unacquired

Connect

0K
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4.2 Using the Micrium® pC/Probe™ Projects

The Micrium pC/Probe is a revolutionary software development tool that incorporates Micrium’s proprietary Graphical Live
Watch to graphically visualize the internals of any embedded system. With pC/Probe, you can test your embedded design
effortlessly, with a few mouse clicks. Cypress provides pre-designed puC/Probe project files for all the example projects
associated with the PSoC 4 M-Series Pioneer Kit except the Deep-Sleep Blinky example project. These projects can be
found in the kit installation directory in the following folder:

<Install Directory>\Cypress\CY8CKIT-044 PSoC 4 M-Series Pioneer Kit\1l.0\Firmware\PSoC
4200M\uC Probe Workspace\

Refer to the Appendix for more details on how to use the Micrium pC/Probe tool. To learn more about the pC/Probe
software, visit: micrium.com/tools/ucprobe/overview.

4.3 Deep-Sleep Blinky

4.3.1 Project Description

This project demonstrates the Deep-Sleep low-power mode of the PSoC 4200M device. The PSoC 4200M device is
configured to be in Deep-Sleep power mode and wakes-up once every second. The PSoC 4200M toggles the state of the
GPIO each time the device wakes up from Deep-Sleep power mode. The GPIO is connected to the LED on the kit which
turns on and off depending upon the GPIO state. The project also demonstrates the method to calibrate the ILO clock
based on the IMO clock signal for better ILO accuracy. The calibrated LFCLK is used to source the Watchdog Timer.

4.3.2 Hardware Connections

No specific hardware connections are required for this project. All connections are hardwired on the board.

4.3.3 Verify Output

To verify the Deep-Sleep Blinky example project, follow these steps.

1. Power the PSoC 4 M-Series Pioneer Kit through USB connector J6.

2. Program the PSoC 4 M-Series Pioneer Kit with the CY8CKIT_044_Deep_Sleep_Blinky example project.
3. After programming successfully, you will see the green LED toggling state every one second.
4

Power off the PSoC 4 M-Series Pioneer Kit by unplugging the USB cable. Remove the jumper shunt from power
measurement jumper of PSoC 4200M on the PSoC 4 M-Series Pioneer Kit (J14).

5. Connect an ammeter across the terminals 3 and 4 of the power measurement header, as shown in Figure 4-4.

Figure 4-4. Current Measurement When Powered From USB Port
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6. Plug in the USB cable back to power the PSoC 4 M-Series Pioneer Kit.

7. Observe the average power consumed by the PSoC 4200M device on the ammeter. The measured average power
must be less than 260pA at 3.3V.

Note: Detailed explanation on the power measurement header terminals is provided in the Hardware Functional Description
section.

4.4 CapSense Proximity
4.4.1 Project Description

This project demonstrates the proximity sensing capability of the PSoC 4200M device. The CapSense scans for an
approaching hand every 100ms and enters a low-power mode if proximity is not detected. This allows the PSoC 4200M to
operate at lower average power levels. The scanning interval is increased and the CapSense scan is performed every
30ms if proximity is detected.

The PSoC 4200M gradually increases the brightness of the green LED as the hand approaches the proximity sensor. If
proximity is not detected for a period more than 3s, the PSoC 4200M increases the CapSense scanning interval to 100ms.

Note: The time periods of 30ms and 100ms are dependent on the LFCLK accuracy. These time periods can be inaccurate
up to 60% when ILO is used as the clock source for LFCLK. Use the ILO Trim Component as demonstrated in the Deep-
Sleep Blinky project to achieve higher accuracy with ILO.

4.4.2 Hardware Connections

Connect the five-inch wire (provided with this kit) to proximity header J10 on the PSoC 4 M-Series Pioneer Kit, as shown in
Figure 4-5.

Figure 4-5. Proximity Sensor Connection on PSoC 4 M-Series Pioneer Kit

4.4.3 Verify Output

To verify the CapSense Proximity example project, follow these steps:

1. Power the PSoC 4 M-Series Pioneer Kit through USB connector J6.

2. Program the PSoC 4 M-Series Pioneer Kit with the CY8CKIT_044_CapSense_Proximity example project.

3. Plug in the proximity sensor wire to the proximity sensor header as shown in Figure 4-6, and press the reset switch
(SW1) of the kit. You should bend the wire to form a loop, as shown in Figure 4-5 to get better proximity range.
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Figure 4-6. Bring Hand Close to the Proximity Sensor

Green LED
fades

Green LED
brightens

4. Bring the hand closer to the proximity sensor, as shown in Figure 4-6. You will see the green LED turn ON.

5. As you move your hand closer to the proximity sensor, the brightness of the LED increases. As you move your hand
away from the proximity sensor, the brightness of the LED decreases.

You will get a proximity range of approximately 6cm with the wire supplied with this kit. You can achieve higher
proximity range by using a larger wire loop. Power consumed by PSoC 4200M for this project can be measured using
an ammeter as described in the Deep-Sleep Blinky project.

4.5 Proximity Gestures

4.5.1 Project Description

This project demonstrates the proximity gesture detection capability of the PSoC 4200M device using CapSense. The
PSoC 4 M-Series Pioneer Kit has two headers which are used to connect proximity wires. These wires are used as
proximity sensors to detect an approaching hand.

The firmware gangs both proximity sensors and scans them as a single proximity sensor every 200ms by default. If the
ganged proximity sensor detects the presence of an approaching hand then PSoC 4200M checks the magnitude of the
signal produced by the proximity sensor. If the proximity signal is less than the threshold value, the RGB LED on the kit is
maintained at a minimum brightness. If the proximity signal is greater than the threshold value, the brightness of the RGB
LED on the kit is varied according to the magnitude of the proximity signal. CapSense scanning interval is changed to to
20ms when the proximity is detected. The project has a proximity range of approximately 5cm.

If proximity is detected, the firmware checks for hand gestures. Two types of gestures are recognized by the firmware — UP
gesture and DOWN gesture. Figure 4-7 shows the UP and DOWN gestures. The color of the RGB LED is changed based
on the recognized gesture. The RGB LED turns off if proximity is not detected for more than 3 seconds. CapSense
scanning interval is changed to 200ms when the proximity is detected.

Note: The gesture is registered only when the hand moves completely from one end to the other over the proximity
Sensors.

Note: The time periods of 20ms and 200ms are dependent on the LFCLK accuracy. These time periods can be inaccurate
up to 60% when ILO is used as the clock source for LFCLK. Use the ILO Trim Component as demonstrated in the Deep-
Sleep Blinky project to achieve higher accuracy with ILO.

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A 27



3; CYPRESS

— £

PERFORM

Example Projects

Figure 4-7. Proximity Gesture Recognition with PSoC 4 M-Series Pioneer Kit (Wave DOWN gesture)
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Table 4-1. Gestures and Actions

With each

wave DOWN gesture,
RGB LED color changes
in the order Red > Blue
> Green > Red.

With each wave
UP gesture, RGB
LED color changes
in the order Red >
Green > Blue >
Red.

Gesture

Action (LED Color Change)

upP

Red > Green > Blue > Red

DOWN

Red > Blue > Green > Red
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45.2 Hardware Connections

Connect five-inch wires (provided with this kit) to proximity jumpers J10 and J11 on the PSoC 4 M-Series Pioneer Kit, as
shown in Figure 4-9.

Figure 4-9. Proximity Sensor Connection on PSoC 4 M-Series Pioneer Kit

4.5.3 Verify Output

To verify the Proximity Gestures example project, follow these steps:

1.
2.
3.

Power the PSoC 4 M-Series Pioneer Kit through USB connector J6.
Program the PSoC 4 M-Series Pioneer Kit with the CY8CKIT_044_Proximity_Gestures example project.

Connect the proximity sensor wires as shown in Figure 4-9, and press the reset switch of the kit (SW1). You should
bend the wire to form a loop, as shown in Figure 4-9 to get better proximity range.

Bring your hand close to the proximity sensors. The RGB LED will turn ON with white color.
The brightness of the LED will increase as you bring your hand closer to the proximity sensors.

Wave the hand at a close proximity from the bottom sensor to the top sensor (UP gesture) to see the LED color change
in the order Red > Green > Blue > Red, one color at a time with each wave.

Wave the hand at a close proximity from the top sensor to the bottom sensor (DOWN gesture) to see the LED color
change in the order Red > Blue >Green > Red, one color at a time with each wave.

Power consumed by PSoC 4200M for this project can be measured using an ammeter as described in the Deep-Sleep
Blinky project.
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4.6 Touch Gestures

4.6.1 Project Description

This example project demonstrates the touch gesture recognition capability of the PSoC 4200M device using the CapSense
Gesture Pad. This Gesture Pad has five buttons arranged similar to a joystick. Figure 4-10 shows the CapSense Gesture
Pad on the PSoC 4 M-Series Pioneer Kit.

Figure 4-10. CapSense Button Pattern

The project gangs all the five CapSense elements of the Gesture Pad and scans them together as a single proximity sensor
every 100ms by default. When the ganged proximity sensor detects an approaching finger, PSoC 4200M turns on the RGB
LED and decreases the scanning interval to 10ms. When a finger touch is detected, the firmware tries to recognize if the
finger has performed any touch gestures. The PSoC 4200M changes the color of onboard RGB LED in different patterns
depending on the detected gestures. Table 4-2 shows the different gestures recognized by the firmware and the
corresponding output action for each gesture.

Table 4-2. CapSense Touch Gestures

Gesture Name Gesture Example Action

Violet > Indigo > Blue > Green > Yellow >

Swipe Clockwise Orange > Red > Violet

Red > Orange > Yellow > Green > Blue >
Indigo > Violet > Red

Swipe Counter-clockwise
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Gesture Name Gesture Example Action
Swipe Right I 5 ) .3 Red > Blue > Green > Red
Swipe Left @ 5 ){) Red > Green > Blue > Red
Dl
Swipe Down @ 5 @ Decrease Light Intensity
Swipe Up 5 @ Increase Light Intensity
A

If a touch is not detected for more than 3 seconds, the PSoC 4200M turns off the RGB LED. CapSense scanning interval is
changed to 200ms when the proximity is detected.

Note: The time periods of 10ms and 100ms are dependent on the LFCLK accuracy. These time periods can be inaccurate
up to 60% when ILO is used as the clock source for LFCLK. Use the ILO Trim Component as demonstrated in the Deep-
Sleep Blinky project to achieve higher accuracy with ILO.

Note: Clockwise and counter-clockwise gestures can be initiated from any sensor except sensor 5.
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4.6.2 Hardware Connections

No specific hardware connections are required for this project. All connections are hardwired on the board.
4.6.3 Verify Output
Power the PSoC 4 M-Series Pioneer Kit through USB connector J6.

Program the PSoC 4 M-Series Pioneer Kit with CY8CKIT_044_Touch_Gestures project.

Bring your finger closer to the Gesture Pad to see the RGB LED turn ON with white color.

p w bdp R

Move your finger on the Gesture Pad on PSoC 4 M-Series Pioneer Kit as mentioned in Table 4-2 to observe the
corresponding LED color and intensity changes. The RGB LED changes the color once after the completion of a
gesture. For example, if you complete a clockwise gesture, the RGB LED changes the color to Indigo if the previous
color was Violet.

Figure 4-11. Verify CapSense Touch Gestures
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5. Clockwise and counter-clockwise gestures are used to make fine color changes. Swipe-left and swipe-right gestures
are used to make coarse color changes. The swipe up and swipe down gestures are used to change the brightness of
the LED. See Table 4-2 for details on how the LED behaves for each gesture.

Note: It requires one full circular swipe (clockwise or counter-clockwise) on the Gesture Pad to see the change in LED
color. However, if the swipe is stopped halfway through the circle and the finger is removed from the board, no gesture
is detected by the PSoC 4200M.

Note: You might get erroneous results if you pick up the PSoC 4 M-Series Pioneer Kit in your hand and try to validate
the output. This is because the PSoC 4200M pins connected to the CapSense Gesture Pad are also connected to the
header J2 and can cause false touches if these pins are touched.

Note: If you hold the finger in close proximity to the Gesture Pad (without touching the sensors) you will observe that
the RGB LED blinks every 3 seconds. This is because, the PSoC 4200M firmware switches to the 100ms scan interval
mode if touch is not detected for more than 3 seconds and turns off the LED. Since the finger is in the range of
proximity sensor after this event, PSoC 4200M turns the LED back on and switches to the 10ms scan interval mode.

Power consumed by PSoC 4200M for this project can be measured using an ammeter as described in the Deep-Sleep
Blinky project.
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4.7 Accelerometer

4.7.1 Project Description

This example project shows a method to interface the onboard digital accelerometer with the PSoC 4200M device. The
accelerometer is assigned with the 12C address OxOF.

The firmware configures the accelerometer to generate an interrupt if motion is detected. PSoC 4200M reads the
accelerometer data whenever the accelerometer generates an interrupt. This information is used to change the color and
intensity of the onboard RGB LED depending on the direction of motion of the kit. Table 4-3 shows the RGB LED color
corresponding to the direction of motion. The intensity of the RGB LED is directly proportional to the magnitude of
acceleration experienced by the sensor. Figure 4-12 shows the accelerometer orientation with respect to the kit.

Figure 4-12. Accelerometer Movement in X-Axis
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Figure 4-14 Accelerometer Movement in Z-axis

Table 4-3. LED Color Corresponding to Direction of Motion

Direction of Motion RGB LED Color
X-axis Red
y-axis Green
z-axis Blue

Note: If the kit is moved in multiple axes, the PSoC 4200M modulates the intensity of RGB LED color corresponding to
each axis depending on the acceleration detected on that axis. For example, if kit is moved in both x- and y- axis, the RGB
LED shows a combination of red and green colors.

4.7.2 Hardware Connections

No specific hardware connections are required for this project. All connections are hardwired on the board.

4.7.3 Verify Output

1. Power the PSoC 4 M-Series Pioneer Kit through USB connector J6.

2. Program the PSoC 4 M-Series Pioneer Kit with CY8CKIT_044_Accelerometer project.

3. Move the PSoC 4 M-Series Pioneer Kit in different directions to see the RGB LED glow as described in Table 4-3.

4.8 Sensor Hub
4.8.1 Project Description

This example project demonstrates the capability of the PSoC 4200M device to function as a sensor hub device. The
PSoC 4200M can interface with multiple digital and analog sensors. In this example project, the PSoC 4200M interfaces an
12C-based accelerometer, a PWM-based temperature sensor, and an ambient light sensor. This example project requires
the associated pC/Probe project files to show the output.

The firmware measures the ambient temperature, ambient light, and the accelerometer values from the sensors and stores
them in global variables. uC/Probe software from Micrium reads these global variables and displays the results in a
graphical format as shown in Figure 4-17. This allows real time monitoring of data in the system.

The firmware changes the brightness of the onboard RGB LED according to the changes made in the RGB Palette in
uC/Probe tool. The firmware also logs the temperature and acceleration data onto the onboard F-RAM device every one
second. Data is stored in the format [temperature data integer part, temperature data fractional part, x axis acceleration
LSB, x axis acceleration MSB, y axis acceleration LSB, y axis acceleration MSB, z axis acceleration LSB z axis acceleration
MSB]. If the F-RAM is full, the firmware rewrites the data from the beginning of the F-RAM.

The firmware also reads back the data logged to F-RAM every one second and sends it through UART. This data can be
read using the KitProg USB-UART bridge. Refer to the KitProg User Guide to learn how to use the KitProg USB-UART
bridge.
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4.8.2 Hardware Connections

No specific hardware connections are required for this project. All connections are hardwired on the board.

4.8.3 Verify Output
1. Power the PSoC 4 M-Series Pioneer Kit through USB connector J6.
2. Program the PSoC 4 M-Series Pioneer Kit with CY8CKIT_044_Sensor_Hub project.

3. Open the Sensor Hub Micrium pC/Probe workspace, CY8CKIT_044 _uC_Probe_Sensor_Hub.wspx, on your computer
from <Install Directory>\CY8CKIT-044 PSoC 4 M-Series Pioneer Kit\<version>\Firmware\PSoC
4200M\uC Probe Workspace.

4. A pop-up window will appear asking you to update the location of the .elf file. The .elf file is located in the project
workspace directory under the folder:

<Project Location>\
CYBCKIT 044 Sensor Hub\CYBCKIT 044 Sensor Hub.cydsn\CortexMO\<Compiler Version>\Debug\
\CYBCKIT 044 Sensor Hub.elf.

Figure 4-15. Locate the .elf file for Sensor Hub Project
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5. Click on Settings button from toolbar and select Cypress PSoC Prog under Communication tab in Settings window.
Select the KitProg in the drop-down corresponding to option Port, and click OK. Refer to step 9 of the Appendix section
Using the Micrium pC/Probe, for detailed explanation on how to connect to the KitProg from uC/Probe.

6. Run the pC/Probe project by clicking the “Run” button on the toolbar.
Figure 4-16. Run the uC/Probe Project
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7. You can monitor the sensor data in the uC/Probe, as shown in Figure 4-17.

Figure 4-17. Global Variables Values Displayed on uC/Probe
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8. Vary the light intensity falling on the ambient light sensor to observe the change in ambient light intensity shown in the
pHC/Probe.

9. Move the kit in different directions to observe the accelerometer data change in the uC/Probe.

10. Move the pointer on the RGB palette in the uC/Probe window to change the color of the onboard RGB LED similar to
the color shown by the RGB palette.

Note: Since the LED physically cannot show a black color, change in the RGB palette to darker side reduces the
brightness of onboard RGB LED. The RGB LED might not show the true color for all color combinations.

11. Open a COM terminal software on your PC, such as HyperTerminal or PuTTY, and connect to the KitProg USB-UART.
Refer to the KitProg User Guide to learn how to use the KitProg USB-UART Bridge with COM terminal software.

12. Set the baud rate for communication as “115200”. Set the Flow Control option to “None”. Observe that the data written
to the F-RAM is read back and displayed in the COM terminal software, as shown in Figure 4-18.
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Figure 4-18. F-RAM Data Read by PSoC 4200M
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13. You can read the data logged by the PSoC 4200M to the F-RAM using the Bridge Control Panel (BCP) software and
KitProg. Refer to the Chapter 5 of the KitProg User Guide to learn how to use KitProg USB-12C bridge with BCP. Type
in the following command in BCP to access the F-RAM data from address location 0x0000 of the F-RAM:

w 50 00 00 r 50 x x X X X X X X P

You can read from any address location of F-RAM by modifying the above command. For example, to read 8 bytes
from address location 0x1234 of F-RAM, use the following command:

w 50 12 34 r 50 Xx X X X X X X X D
Refer to the Appendix A.4 to understand how the F-RAM communicates with an I12C master.

Note: This project is not configured to operate in an 12C multi-master environment. If you are using Bridge Control
Panel tool to read the F-RAM data log, reset the PSoC 4 M-Series Pioneer Kit before using the uC/Probe tool to view
the data. If the COM terminal software is connected, it displays an error message to indicate communication failure.
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Example Projects

Figure A-4. Peripheral Schematic
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A.2. Using the Micrium pC/Probe

The Micrium pC/Probe is a software development tool that incorporates Micrium’s proprietary Graphical Live Watch to
graphically visualize the internals of any embedded system. With puC/Probe, you can debug your embedded design
effortlessly, with just a few mouse clicks. You can download the uC/Probe Users’ Guide and uC/Probe Target Manual from
the following webpage: pC/Probe User Guide and pC/Probe Target Manual. To learn more about the pC/Probe,
visit: micrium.com/tools/ucprobe/overview/.

Appendix

Micrium pC/Probe allows you to monitor the values of all the global variables in your project while the project is running on
the PSoC 4200M. These values can be mapped on to multiple graphical interface elements provided by the puC/Probe
software, such as angular gauges or numeric indicators. This allows you to use the uC/Probe as an effective debug tool
because it does not halt the CPU.

A.2.1 Installing and Using the uC/Probe

1. Visit the Micrium website to download the Student Edition of the uC/Probe software. You can also purchase a license
for Professional Edition of pC/Probe from Micrium to access all the features in this software. The Windows installer
setup for pC/Probe is available at micrium.com/download/ucprobe-3-0-trial-version/.

Note: You have to register an account with Micrium to download this software.
2. Install the uC /Probe on your computer.
3. Open Micrium pC/Probe from Start > Micrium > uC-Probe > Micrium uC-Probe.

Note: Refer to the uC/Probe User Manual for detailed information on the pC/Probe. You can access this from Start >
Micrium > uC-Probe > User Manual.

Figure A-5. Micrium uC-Probe in Start Menu

. Micrium a
. u-Probe
|| Home Page
4 Micrium uC-Probe
m Target Manual
[ Uninstall Micriurn uC-Probe
'EI User Manual

4. The PSoC 4 M-Series Pioneer Kit gives you a 1 month free license for the pC/Probe Professional Edition. Refer to the
HC/Probe License Card for the pC/Probe license key. To activate the license, click on File > Activation. In the License
Manager window, type in the license key and press Activate as shown in Figure A-6.

Figure A-6. pC/Probe Activation
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@ Save As
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5. In uC/Probe, you can drag and drop the desired graphical elements to the “DataScreen” grid for debugging.

Figure A-7. Drag and Drop pC/Probe Graphical Elements
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6. These graphical elements are linked to the global variables running on the PSoC 4200M through the .elf generated by
the PSoC Creator. To link the .elf file, click the ELF button in the Symbol Browser and navigate to the project .elf file.

The .elf file of a project is located at: <Project Directory>\<Project Name.cydsn>\CortexMO\<Compiler
Version>\<Debug> or <Release>\<Project Name.elf>.

Figure A-8. Add New Symbol File
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7. Navigate to the .c file displayed in the Symbol Browser and drag and drop the global variable in the file to the graphical
element in DataScreen to link the variable. You can configure to view multiple variables on the same DataScreen.

Figure A-9. Link Global Variables to Graphical Elements
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8. You can click on the graphical elements to bring up the settings for each individual graphical element, as shown in

Figure A-10.

Figure A-10. Settings for Graphical Elements
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9. Select the File menu of the pC/Probe and click Settings.

Figure A-11. pC/Probe Settings

& Mew Warkspace

E Open

E Save
B Save As

This document descri
application including:

5 Close

- - Symbaol Browser,
@ - Communication Set
- - Workspace Explorer

User's Manual - Virtual Centrols and

“ Check Updates

%, Activation

m Exit

- Layout Design Tools
- Associating Symbaol:
- pC/OS-I Kernel Aw

This document descri
in the emheddesd tarm

Example Projects

10. Select the Communication tab from the Settings window. Click the Cypress PSoC Prog option and select the
KitProg/<serial number> from the drop-down menu. Select OK to close the dialog box.

Figure A-12. KitProg Connection in uC/Probe

Micriprm pC/Probe

HC/Probe Settings

Endianness Statistics

Interfaces

uaneaunwwo] A7

Target Resident Code

(& TcRP

(& Rs-232

(o use

Debug Interfaces

L’

& )-Link

(&0 cmsIs-DAR

[eszuzn Gl

I ;3 Cypress PSoC Prog ]

Data Collection

@ Little Endian ) symbols/sec | | | | | | | ||| | |

) Big Endian @ bytes/sec

None Settings

Cloud Only Part -

KitProg{0A15022A011A3400

(818 | [ Cancel

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A

45



)

P

o

==/ CYPRESS

Appendix

11. Program the same project for which the ELF files are loaded onto your PSoC 4200M device.
12. Select Run from the toolbar to view the status of the global variable you want to monitor.

Figure A-13. Run the uC/Probe Project
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13. Complete the DataScreen design and run the project to see the variable values graphically.

Figure A-14. uC/Probe Project Running
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A.3. Hardware Functional Description

This section provides detailed explanation on individual hardware blocks of the PSoC 4 M-Series Pioneer Kit. Complete
schematic of the PSoC 4 M-Series Pioneer Kit can be accessed from the PSoC 4 M-Series Pioneer Kit webpage or the kit
install directory.

Figure A-15. Board Highlight of Hardware Components
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A.3.1 PSoC 4200M

This kit uses the PSoC 4200M (CY8C4247AZI-M485) family device (marked 6 in Figure A-15). PSoC 4 is a scalable and
reconfigurable platform architecture for a family of programmable embedded system controllers with an ARM Cortex-MO
CPU. It combines programmable and reconfigurable analog and digital blocks with flexible automatic routing. The
PSoC 4200M device family, based on this platform architecture, is a combination of a microcontroller with digital
programmable logic, programmable analog, programmable interconnect, high-performance analog-to-digital conversion,
opamps with comparator mode, and standard communication and timing peripherals. The PSoC 4200M products will be
fully compatible with members of the PSoC 4 platform for new applications and design needs. The programmable analog
and digital subsystems allow flexibility and in-field tuning of the design. For more information, refer to the PSoC 4200M web
page and the PSoC 4200M Family Datasheet.

A.3.2 PSoC5LP

An onboard PSoC 5LP (CY8C5868LTI-LP039) is used to program and debug PSoC 4200M device (marked 4 in Figure A-
15). The PSoC 5LP connects to the USB Mini-B connector of the PC through a USB Mini-B connector and to the SWD
interface of the PSoC 4200M device. PSoC 5LP is a true system-level solution providing MCU, memory, analog, and digital
peripheral functions in a single chip. The CYBC58LPxx family offers a modern method of signal acquisition, signal
processing, and control with high accuracy, high bandwidth, and high flexibility. Analog capability spans the range from
thermocouples (near DC voltages) to ultrasonic signals.

For more information, visit the PSoC 5LP web page. Also, refer to the CY8C58LPxx Family Datasheet.

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A 47


http://www.cypress.com/psoc4200m
http://www.cypress.com/psoc4200m
http://www.cypress.com/?rID=108039
http://www.cypress.com/psoc5lp
http://www.cypress.com/?rID=72824

N

=_,‘ CYPRFSS

PERFORM

Appendix
A.3.3 Power System

The power supply system on this board is versatile, allowing the input supply to come from the following sources:

m 5.V power from onboard USB connector

®  5-Vto 12-V VIN power from Arduino Shield

®  5-V power from the Raspberry Pi

The PSoC 4 M-Series Pioneer Kit is powered at 5 V directly from the USB power supply. An LDO is used to output 3.3 V to
power the PSoC 4200M device (marked 3 in Figure A-15). These voltages are selected through the J9 jumper, as shown in
Figure A-16.

Figure A-16. Schematics of LDO and Power Selection Jumper
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10 uFd 25v 1~ usa  LDO 1200hm ¢ | DB —~22 uFd 16v °
; Short 1 and 2 for 3.3V setting
Short 2 and 3 for 5V setting

The input to the LDO can be from either the USB or the VIN pin in the Arduino header.

Protection Circuits

The power supply rail has reverse-voltage, overvoltage, short circuit, and excess current protection features, as shown in
Figure A-17.

Figure A-17. Power Supply Block Diagram with Protection Circuits

1/0 Header

5V Vin

3.3V

ADJ LDO

5V—» Current measurement

§ VBUS Puw?lznf;\;ction header
PTC RPi 5V
Raspberry Pi KitProg 10-Pin
Header Prog. Header "l KitProg ;
ESD PSoC 4200M 10-Pin
Protection 7 Prog. Header

m A PTC resettable fuse is connected to protect the computer's USB Mini-B connectors from shorts and over current.

B ORing diodes prevent damage to components when the board is powered from different voltage sources at the same
time.

®  ESD protection is provided for the USB Mini-B connector.
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To measure the PSoC 4200M power consumption, a header is populated in series with the power supply to the PSoC
4200M, which can be used to measure current using an ammeter without the need to de-solder any components from the

board (marked 17 in Figure A-15).

The following two methods are supported for measuring the current consumption of the PSoC 4200M device.

Figure A-18. Schematics of Current Measurement Jumper
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J14 Jumper Settings
1l & 3 -> 10 Ohm Shunt
2 & 4 -> 1 Ohm Shunt

3 & 4 -> Short out shunts

Power Monitoring

®  When the board is powered through the USB Mini-B connector (J6), remove jumper J14 and connect an ammeter
between terminals 3 and 4, as shown in Figure A-19.

Figure A-19. Current Measurement When Powered From USB Connector
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®  When the PSoC 4 M-Series Pioneer Kit is powered from an external voltage supply, remove the USB cable from J6.
Connect the positive terminal of the external voltage supply to the positive terminal of the ammeter and the negative
terminal of the ammeter to pin 4 of J14. Connect the negative terminal of the external voltage supply to and GND pin

on the board. Figure A-20 shows the required connections.
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Figure A-20. Current Measurement When Powered Separately
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Note: When the PSoC 4200M is powered separately and not through the USB, remove the resistors R63 and R64 to avoid
leakage while measuring current.

A.3.4 Expansion Connectors

Arduino Compatible Headers (J1, J2, J3, J4, and J12—unpopulated)

This kit has five Arduino compatible headers—J1, J2, J3, J4, and J12. Header J1 is marked 10 and header J2, J3, and J4
are marked 13 in Figure A-15. You can develop applications based on the Arduino Shield’s hardware.

The J1 header contains I/O pins for reset, I/O reference voltage (IOREF), and power supply line. The J2 header is an
analog port that contains 1/O pins for SAR ADC, comparator, and opamp. The header J3 also has I/O pins that support
connection to PSoC 4200M CAN. The J3 header is primarily a digital port that contains 1/O pins for PWM, 12C, SPI, and
analog reference. The J4 header is also a digital port that contains I/O pins for UART and PWM. The J12 header is an
Arduino ICSP compatible header for the SPI interface and is not populated. Refer to the “No Load Components” section of
the Bill of Materials for the header part number.

Note: Pin P1[7] has a 1.0-uF capacitor connected to it. This is provided as a bypass capacitor for the PSoC 4200M SAR
ADC. Remember to remove this capacitor if you are planning to use this pin for any other purposes.
Additional Functionality of Header J2

The J2 header is a 9x2 header that supports Arduino Shields. Some pins from port O, port 2, port 3, port 4, and port 6 pins
of PSoC 4200M are brought to this header. The port 3 and port 4 pins also connect to the onboard CapSense Gesture Pad
through 560-ohm resistors. When the CapSense feature is not used, you may remove these resistors if necessary to help
ensure better performance with these pins.

Functionality of Unpopulated Header J12

The J12 header is a 2x3 header that supports Arduino Shields. This header is used on a small subset of Shields and is
unpopulated on the PSoC 4 M-Series Pioneer Kit.
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Pmod Connector — Digilent Pmod Compatible (J16—unpopulated)

This port supports Digilent Pmod Peripheral Modules (marked 8 in Figure A-15). Pmods are small 1/O interfaces that
connect with embedded control boards through either 6 or 12-pin connectors. The PSoC 4 M-Series Pioneer Kit supports
the 6-pin Pmod type 2 (SPI) interface. For Digilent Pmod Peripheral Modules, go to www.digilentinc.com.

This header is not populated on the PSoC 4 M-Series Pioneer board. You must populate this header before connecting
Pmod Peripheral Modules. Refer to the “No Load Components” section of the Bill of Materials for the header part number.

PSoC 5LP GPIO Header (J8)

An 8x2 header is provided on the board to bring out several pins of PSoC 5LP to support advanced features such as a low-
speed oscilloscope and a low-speed digital logic analyzer (marked 5 in Figure A-15). This header also contains the USB-
UART bridge pins and USB-I2C bridge pins that can be used when these pins are not accessible on the Arduino headers
because a Shield is connected.

A.3.5 USB Mini-B Connector

The PSoC 5LP connects to the USB Mini-B connector of a PC through a Mini-B connector (marked 2 in Figure A-15), which
can also be used to power the PSoC 4 M-Series Pioneer Kit. A resettable polyfuse is used to protect the computer's USB
port from shorts and over current. If more than 500mA is drawn from the USB Mini-B connector, the fuse will automatically
break the connection until the short or overload is removed.

A.3.6 CapSense Circuit

CapSense Gesture Pad

The kit has a five element capacitive Gesture Pad on the board, which is connected to PSoC 4200M module pins (marked
18 in Figure A-15). The CMOD and CTANK capacitors essential for CapSense functionality are connected on the board. A
2.2-nF capacitor is present on the CMOD pin, P4[2], for CapSense operation. This kit also supports CapSense designs that
enable waterproofing. On this kit, the Shield is connected to the pin or to ground by resistors R57 and R58, respectively. By
default, R58 is mounted on the board, which connects the Shield to ground. Remove R58 and populate R57 when
evaluating waterproofing designs, which will connect the Shield to the designated pin, PO[1].

Proximity Header

The PSoC 4 M-Series Pioneer board contains two headers (J10 and J11) for CapSense Proximity sensor connection
(marked 16 in Figure A-15). If the proximity functionality is not being used, these can be used as standard GPIO pins.

A.3.7 Pioneer Board LEDs

The Pioneer board has three LEDs. A green LED (LED1) indicates the status of the KitProg. See the Troubleshooting
section in KitProg User Guide for more information on LED states. An amber LED (LED2) indicates the status of power
supplied to the board. The kit also has a general-purpose RGB LED (LED3) for user applications (marked 1 and 11 in
Figure A-15).

A.3.8 Push Buttons

The board contains a reset push button and a user push button (marked 9 and 12 in Figure A-15). The reset push button is
connected to the XRES pin of PSoC 4200M and is used to reset the device. The user push button is connected to P0O[7] of
the PSoC 4200M device. Both the push buttons connect to ground on activation (active low).

A.3.9 Cypress Ferroelectric RAM (F-RAM)

The PSoC 4 M-Series Pioneer Kit contains an F-RAM device (FM24V10-G) (marked 20 in Figure A-15) that can be
accessed through 12C lines P4[0] and P4[1] of the PSoC 4200M device. The F-RAM has a capacity of 1-Mbit (128 KB) with
an 12C speed up to 1 Mbps. The 12C slave address of the F-RAM device is 7 bits wide, and the two least significant bits are
configurable through physical pins. These pins are hardwired to 00 on the board. By default, the address of the F-RAM
device used on the kit is 0x50. This address can be modified by changing the R21/R20 and R23/R22 resistor pairs. The
operating voltage range of the F-RAM is between 2 V and 3.6 V. To prevent the F-RAM from operating at voltages greater
than 3.6V, the power supply to the F-RAM is derived from the output of the 3.3-V regulator. The I12C lines are connected to
the 3.3 V side of the onboard level translator to help F-RAM communicate with PSoC 4200M operating at 5 V.
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A.3.10 3-Axis Accelerometer

The PSoC 4 M-Series Pioneer Kit has a 3-Axis accelerometer (marked 15 in Figure A-15). The acceleration change
detected by this device can be used to determine the direction of motion of the kit. The PSoC 4200M communicates with
the accelerometer through an 12C interface.

Note that the 12C accelerometer is connected on to the same 12C bus on which the KitProg USB-I2C bridge and the F-RAM
is connected. The accelerometer is assigned with the 12C address 0xOF.

Refer to the KXTJ2-1009 Datasheet for more information on how to configure the accelerometer.

A.3.11 PWM Temperature Sensor

A PWM temperature sensor is included on the PSoC 4 M-Series Pioneer Kit (marked 19 in Figure A-15). This sensor is also
known as a TMPO5 sensor and can indicate the measured temperature by varying the duty cycle of the PWM output
generated by the sensor.

Refer to the TMPO5 Datasheet for more details on the operation of this sensor. Note that the sensor is configured to operate
in daisy chained mode.

A.3.12 Ambient Light Sensor

The PSoC 4 M-Series Pioneer Kit includes an analog ambient light sensor (marked 21 in Figure A-15). This is a photodiode
configured in photoconductive mode for detecting the changes in the ambient light intensity.

The photodiode is intended to be connected to the input of a transimpedance amplifier. A 220-KQ resistor and a 0.1-uF
capacitor are connected across the pins P5[1] and P5[2] to for implementing a transimpedance amplifier. Refer to the
TEMD6200FX01 datasheet for the electrical characteristics of the photodiode.

A.3.13 Serial Interconnection Between PSoC 5LP and PSoC 4200M

In addition to use as an onboard programmer, the PSoC 5LP is used as a USB-Serial interface for the USB-UART bridge
and USB-I2C bridge, as shown in Figure A-15. The 12C bus contains firmware-controlled resistive pull-ups using FET, which
can be enabled or disabled using the PSoC 5LP pins. The USB-Serial pins of the PSoC 5LP are also available on the
Arduino header; therefore, the PSoC 5LP can be used to control Arduino Shields with an SPI/I2C/UART interface.

Note: The KitProg does not support USB-SPI bridge functionality. The SPI pins of the PSoC 4200M are connected to the
PSoC 5LP for enabling SPI communication between PSoC 5LP and PSoC 4200M for custom PSoC 5LP applications.

Figure A-21. Schematics of Serial Interface Connections and 12C Pull-Up via FET
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A.3.14 Raspberry Pi Compatible Header

The PSoC 4 M-Series Pioneer Kit has a Raspberry Pi compatible header (marked 14 in Figure A-15). This header (J15) is
not populated by default. Refer to the “No Load Components” section of the Bill of Materials for the header part number.
Alternately, you may use the header from Samtec Inc. (part number: ESQ-113-44-G-D). All the serial communication pins
are brought onto this header. Note that GPIO pins of the Raspberry Pi are not connected to the PSoC 4 M-Series Pioneer
Kit using this interface.

The Raspberry Pi pins are intolerant to voltages above 3.3 V. A level translator is included on the board to automatically
convert the digital logic voltages to the 3.3-V domain regardless of the power settings on the PSoC 4 M-Series Pioneer Kit.

Figure A-22. PSoC 4 M-Series Pioneer Kit Connected to a Raspberry Pi Model B
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A.3.15 Level Translators

The PSoC 4 M-Series Pioneer Kit has two level translators. The level translators are used on this kit to translate digital 5-V
logic signals to 3.3 V. One level translator connects the 12C and UART signals from PSoC 4200M to the Raspberry Pi
compatible header. It also connects to the 12C bus of the accelerometer as shown in Figure A-15.

The level translator, which connects the 12C and UART interfaces to the Raspberry Pi is always on. This ensures that you
can read the accelerometer data without connecting a Raspberry Pi. This level translator also connects to the 3-Axis
accelerometer and the Cypress F-RAM device. The level translator, which interfaces SPI lines of PSoC 4200M to the
Raspberry Pi, is switched on automatically when a Raspberry Pi is connected to the PSoC 4 M-Series Pioneer Kit.

Figure A-23. Level Translators on PSoC 4 M-Series Pioneer Kit
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A.3.16 Test Points

The SWD programming pins for the PSoC 4200M are brought out as test points on the PSoC 4 M-Series Pioneer Kit. You

can solder standard 100-mil connectors to these test points to program an external PSoC device using the on-board PSoC
5LP.

Note: You must remove the zero ohm resistors R51, R53, and R55 before programming an external PSoC device.

Figure A-24. SWD Programming Pins Brought as Test Points
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All power domains (VDDA, VDDD, and VDDIO) including VIN, 3.3V and GND are also brought as test points for easy
probing.
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A.4. Using FM24V10 F-RAM

This chapter describes advanced features of the PSoC 4 M-Series Pioneer Kit as well as the corresponding projects. It can
be used as a reference to exploit these features for other applications, according to the needs of the project.

Appendix

The PSoC 4200M Pioneer board has an onboard ferroelectric RAM chip that can hold up to 1 Mb of data. The chip provides
an 12C communication interface for data access. It is hardwired to the 12C interface (P4[0] and P4[1] of the PSoC 4200M);
the same lines are routed to the PSoC 5LP [12C interface. Because the F-RAM device is an 12C slave, it can be accessed or
shared among various 12C masters on the same lines. For more details on the F-RAM device, refer to the device datasheet.

A.4.1 Address Selection

The slave address of the F-RAM device consists of three parts, as shown in Figure A-15: slave ID, device select, and page
select. Slave ID is an F-RAM family-specific ID provided in the datasheet of the particular F-RAM device. For the device
used on the PSoC 4200M Pioneer board (FM24V10), the slave ID is 1010b. Device select bits are set using the two
physical pins A2 and Al in the device. The setting of these two pins in PSoC 4200M Pioneer board is controlled by resistors
R21/R20 (Al) and R23/R22 (A2). Because the memory location in F-RAM is divided into two pages of 64 KB each, the
page select bit is used to refer to one of the two pages in which the read or write operations will take place.

Figure A-25. F-RAM 12C Address Byte Structure
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1 0 1 0 | A2 | A1 |A16 |[R/W
}
\— Slave ID 4/\—Device —/ Page
Select select

A.4.2 Write/Read Operation

The F-RAM device datasheet includes details on how to perform a write/read operation with the F-RAM. Figure A-26 and
Figure A-27 provide a snapshot of the write/read packet structure as a quick reference.

Figure A-26. F-RAM Single-Byte and Multiple-Byte Write Packet Structure

Single-Byte Write

Start Address & Data Stop

T T TT T T T T T T T T T T T
S | Slave Address g 0] A Address MSB A Address LSB A Data Byte AlP
T I Y T Y T O T I Y

By F-RAM ﬁ * *

Acknowledge

il

Multi-Byte Write

Stop
By Master Address & Data i
FTT 1T P\ FT T T T T FTT T T T T FT T T TTT FT T T TTT
S| Slave Address s 0A Address MSB A Address LSB A Data Byte A Data Byte AP
I I Y I Y e I S B N Y I
By F-RAM * + *
Acknowledge

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A 56


http://www.cypress.com/?rID=73495

Figure A-27. F-RAM Single-Byte and Multiple-Byte Read Packet Structure
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Appendix

As the figures show, operations start with the slave address followed by the memory address. For write operations, the bus
master sends the slave address and memory address followed by one or more data bytes. Each byte of data is written to
consecutive locations in the memory, and the memory generates an acknowledgement condition.

For ‘Current Address Read’ and ‘Sequential Read’, the bus master sends only the slave address. The memory address
used is the same address that was set by the previous ‘Write’ or ‘Selective Read’ operation. For ‘Selective Read’
operations, after receiving the complete slave address and memory address, the memory will begin shifting data from the
current address on the next clock

Note: The example project Sensor Hub uses the onboard F-RAM. See the Sensor Hub project to understand how to
communicate with the F-RAM device using PSoC 4200M device. You can also communicate with the F-RAM using the
Bridge Control Panel (BCP) software similar to the way you communicate with any other 12C slave device. Refer to the
KitProg User Guide for more details on how to use the BCP to communicate with an I2C slave device.

CYB8CKIT-044 PSoC® 4 M-Series Pioneer Kit Guide, Doc. No. 001-96598 Rev. *A

57



==

=7 CYPRESS .
Appendix

FERFORM

A.5. Migrating Projects Across Different Pioneer Series Kits

All Cypress Pioneer series kits are Arduino Uno compatible and have some common on-board peripherals such as RGB
LED, CapSense and User Switch. However, the pin mapping in each of the boards is different due to differences in pin
functions of the PSoC device used. This section lists the pin maps of the Pioneer series kits to allow for easy migration of

projects across different kits.

In some cases, the pins available on the Pioneer kit headers are a superset of the standard Arduino Uno pins. For example,
J2 contains only one row of pins on the Arduino Uno pin layout while it contains 2 rows of pins on many of the Pioneer

series Kits.

Figure A-28. Pioneer series kits pin map

Arduino compatible

1/0 headers
Arduino compatible
power header
CY8CKIT-042-BLE
6x2 header
CYB8CKIT-042 & CYBCKIT-044
9x2 header
A.5.1 Arduino Uno Compatible Headers
Table A - 1. J1 Arduino Compatible Header Pin Map
. ) . Pioneer Series Kits
Pin # Arduino Pin
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044
1 VIN VIN VIN VIN VIN
2 GND GND GND GND GND
3 GND GND GND GND GND
4 5V V5.0 V5.0 V5.0 V5.0
5 3.3V V3.3 V3.3 V3.3 V3.3
6 RESET RESET RESET RESET RESET
7 IOREF P4.vDD P4.vDD BLE.VDD P4.vDD

8 NC NC NC NC NC
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Table A - 2. J2 Arduino Compatible Header Pin Map
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S Arduine Pin Pioneer Series Kits
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044
1 A0 P2[0] PO[0] P3[0] P2[0]
2 — PO[2]* — P2[0] P2[6]*
3 Al P2[1] PO[1] P3[1] P2[1]
4 — PO[3]* — P2[1]* P6[5]*
5 A2 P2[2] PO[2]* P3[2] P2[2]
6 — P4_VDD — P2[2]* PO[6]*
7 A3 P2[3] PO[4]* P3[3] P2[3]
8 — P1[5]* — P2[3]* PA[4]*
9 A4 P2[4] P1[3] P3[4] P2[4]
10 — P1[4]* — P2[4]* P4[5]*
11 A5 P2[5] P1[2] P3[5] P2[5]
12 _ P1[3]* — P2[5]* P4[6]*
13 — PO[0] — — PO[0]
14 — GND — — GND
15 — PO[1] — — PO[1]
16 — P1[2]* — — P3[4]*
17 — P1[0] — — PO[7]*
18 — P1[1]* — — P3[5]*

* These pins are also used for on-board peripherals

connection details.

Table A - 3. J3 Arduino Compatible Header Pin Map

. See the tables in the On-Board Peripherals section below for

B Arduino Bin Pioneer Series Kits
CYB8CKIT-042 CYB8CKIT-040 CYBCKIT-042-BLE CY8CKIT-044
1 D8 P2[6] P1[4] PO[5] PO[2]
2 D9 P3[6] P1[5] PO[4] PO[3]
3 D10 P3[4] P1[6] PO[2] P2[7]
4 D11 P3[0] P1[1]* PO[0] P6[0]
5 D12 P3[1] P3[1] PO[1] P6[1]
6 D13 PO[6] P1[7] PO[3] P6[2]
7 GND GND GND GND GND
8 AREF P1[7] NC VREF P1[7]
9 SDA P4[1] P1[3] P3[4] P4[1]
10 SCL P4[0] P1[2] P3[5] P4[0]

* These pins are also used for on-board peripherals. See the tables in the On-Board Peripherals section below for

connection details.
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Table A - 4. J4 Arduino Compatible Header Pin Map

Appendix

Pioneer Series Kits

Pin # Arduino Pin
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044
1 DO PO[4] PO[5] P1[4] P3[0]
2 D1 PO[5] PO[6] P1[5] P3[1]
3 D2 PO[7]* PO[7] P1[6] P1[0]
4 D3 P3[7] P3[2]* P1[7] P1[1]
5 D4 PO[0] PO[3] P1[3] P1[2]
6 D5 P3[5] P3[0] P1[2] P1[3]
7 D6 P1[0] P1[0] P1[1] P5[3]
8 D7 P2[7] P2[0]* P1[0] P5[5]

* These pins are also used for on-board peripherals. See the tables in the On-Board Peripherals section below for
connection details.

A.5.2 On-Board Peripherals
Table A - 5. CapSense Pin Map

Pioneer Series Kits

Pin # Arduino Pin
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-042
1 Css1 P1[1] — P2[1] P4[4]
2 CSS2 P1[2] — P2[2] P4[5]
3 CSS3 P1[3] — P2[3] P4[6]
4 CSS4 P1[4] — P2[4] P3[4]
5 CSS5 P1[5] — P2[5] P3[5]
6 CMOD P4[2] PO[4] P4[0] P4[2]
7 CTANK P4[3] PO[2] P4[1] P4[3]
Table A - 6. Proximity header Pin Map
. . . Pioneer Series Kits
Pin # Arduino Pin
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044
— P2[0] P2[0] P3[7]
PROXIMITY
— — — P3[6]
Table A - 7. RGB LED Pin Map
. . . Pioneer Series Kits
Pin # Arduino Pin
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044
Red P1[6] P3[2] P2[6] PO[6]
Green PO[2] P1[1] P3[6] P2[6]
Blue PO[3] PO[2] P3[7] P6[5]
Table A - 8. User Switch Pin Map
. . . Pioneer Series Kits
Pin # Arduino Pin
CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044
1 SW2 PO[7] _ P2[7] PO[7]
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A.6. KitProg Status LED States

Appendix

The KitProg Status LED on the development kit indicates the status of the KitProg operation using different blink rates.
Table A - 9 shows the KitProg LED States and the corresponding status of the KitProg.

Table A - 9. Meaning of KitProg LED States

# User Indication Scenario

Action Required by User

. . LED starts blinking at power
, | LED blinks fast: up, if bootloadable file is
Frequency = 4.00 Hz corrupt.

Bootload the KitProg.cyacd file: in PSoC Programmer, connect to
the kit, open the Utilities tab and press Upgrade Firmware
button.

. . Entered Bootloader mode by
2. LED blinks slow- holding the kit. Reset button

Frequency = 0.67 Hz during kit power-up.

Release the Reset button and re-plug power if you entered this
mode by mistake. If the mode entry was intentional, bootload the
new.cyacd file using the Bootloader Host tool shipped with PSoC
Creator.

SWD operation is in progress.

LED blinks very fast: ) .
3. Any 12C traffic. Kit's COM port

Frequency = 15.0 Hz connect/disconnect event (one
blink).

In PSoC Programmer, watch the log window for status messages
for SWD operations. In the Bridge Control Panel, the LED blinks
on I12C command requests. In BCP or any other serial port
terminal program, distinguish the kit's COM port number by the
blinking LED when the port is connected or disconnected.

USB enumeration successful.
Kit is in the idle state waiting
for commands.

4 | LEDis ON.

PSoC Creator, PSoC Programmer, Bridge Control Panel, and any
serial port terminal program can use the kit functions.

5 | LED is OFF. Power LED is ON.

This means that the USB enumeration was unsuccessful. This
can happen if the kit is not powered from the USB host or the kit is
not connected to the USB host through the USB cable. Verify the
USB cable and check if PSoC Programmer is installed on the PC.
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A.7. Bill of Materials

Appendix

Item | Qty Reference Value Description Manufacturer Mfr Part Number
PCB, 98.66 mm x 61.70
1 |1 |600-60221-01 REVO2 _ mm, High Tg, ENIG | Cypress 600-60221-01
finish, 4 layer, Color = | Semiconductor
RED, Silk = WHITE
C1,C2,C3,C6,C8,C13,C14,C
18,C20,C21,C24,C25,C27,C CAP .1UF 16V .
2 25 32.C35.C37.C38.C39.C40.C 0.1 uFd CERAMIC X5R 0402 TDK Corporation |C1005X5R1A104K050BA
42,C44,C45,C46,C49,C50
CAP TANT 22UF 16V .
3 1 [C4 22 uFd 16v 10% 1210 AVX Corporation |TPSB226K016R0600
CAP TANT 10UF 20V .
4 1 |C5 10 uFd 20v 10% 1210 AVX Corporation |TAJB106K020RNJ
CAP CER 18PF 50V .
5 1 |C9 18 pF 1% NPO 0402 Murata Electronics | GRM1555C1H180FA01D
CAP CER 36PF 50V .
6 1 |[C10 36 pF 5% NPO 0402 Murata Electronics | GRM1555C1H360JA01D
C11,C12,C15,C16,C22,C26,
7 |14 |C28.C29,C30,C31,C33.C34, |1.0 uFd CAP CERAMIC LOUF |.r 6 vden TMK107BJ105KA-T
25V X5R 0603 10%
C36,C47
CAP CER 10000PF
8 1 C19 10000 pFd 50V 5% NP0 0805 Murata GRM2195C1H103JA01D
CAP CER 2200PF 50V
9 1 C23 2200 pFd 5% NP0 0805 Murata GRM2165C1H222JA01D
CAP CER 0.1UF 16V
10 1 C41 0.1 uF 10% X7R 0603 Murata GRM188R71C104KA01D
CAP 10000PF 16V .
11 1 |[C43 0.01 uFd CERAMIC 0402 SMD TDK Corporation |[C1005X7R1C103K050BA
AMBIENT LIGHT Vishay
12 1 D1 TEMD6200FX01 SENSOR 0805 SMD Semiconductor TEMD6200FX01
D2,D3,D4,D5,D6,D7,D8,D9, DIODE SCHOTTKY Fairchild
13 10 D10,D11 MBRO520L 0.5A 20V SOD-123 Semiconductor MBRO520L
PTC RESETTABLE
14 1 F1 FUSE '50A 15V 1812 Bourns MF-MSMF050-2
CONN HEADER Protectron
15 2 J1,J4 8x1 RECP FEMALE 8POS .1" P9401-08-21
Electromech
GOLD
CONN HEADER FMAL |Protectron
16 1|2 9x2 RECP 18PS.1" DL GOLD Electromech P9403-18-21
CONN HEADER Protectron
17 1 J3 10x1 RECP FMALE 10POS .1 Electromech P9401-10-21
GOLD
18 |1 |6 USB MINI B D! USB RCPT RIA | Molex Inc 0548190519
CONN HEADER FMAL |Protectron
9 |1 |8 8X2 RECP 16PS.1" DL GOLD Electromech P9403-16-21
CONN HEADR Protectron
20 1 J9 3p_jumper 2$§WAY .100 3POS Electromech P9101-03-12-1
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Iltem | Qty Reference Value Description Manufacturer Mfr Part Number
21 |2 |310911 1X1 RECP CONNRCPTIPOS | samtec Inc BCS-101-L-S-HE
2 |1 |4 2X2 RECP SO ERDER 100 Protectron P9103-04-12-1
23 |1 |LED1 étr?etg: LED BESS%E%EN CLEAR | Chicago Miniature |CMD17-21VGC/TR8
w | | oo mommnre [ g
LED CLV1A-FKB-
25 |1 |LED3 RGB LED RED/GREEN/BLUE  |Cree, Inc. e a3
PLCC4 SMD
26 |2 |L1L2 fgg,\‘/’lm @ T;Z%EO%H'P 330 OHM |\1 irata Electronics |BLM18SG331TNLD
27 |1 |r1 820 ohm B oy UBW | panasonic - ECG | ERJ-6GEYJ821V
28 |1 |R2 560 ohm RS oo oM VBW I panasonic - ECG | ERJ-6GEYJS61V
R3,R8,R16,R17,R19,R20,R2
29 |21 (R e Rel Rea nee e |ZERO RS 40 OHMAOW I panasonic - ECG | ERJ-3GEYOR00V
9.R63.R64
30 |2 |R5R6 22F RES 22 Qe VO | panasonic - ECG | ERJ-3EKF22ROV
31 |3 |RoR30,R35 2.2K B VIOW | panasonic - ECG  |ERJ-3GEYJ222V
32 |2 |R10R11 1.5K B VIOW | panasonic - ECG  |ERJ-3GEYJI152V
33 |3 |R12,R61,R65 10K B o VIOW | panasonic - ECG | ERJ-3GEYJ103V
34 |1 |R13 220K RS i 220K OAM | panasonic - ECG | ERJ-3GEYJ224V
3 |2 |R14R15 10K 5R<>5050182K g,\'/l"g' VIBW |y ageo RC0402JR-0710KL
3% |1 |Ri8 100K B oM VIOW | panasonic - ECG  |ERJI-2GEJ104X
37 |1 |Res 120 ohm R e o VIOW | banasonic - ECG | ERJ-3EKF1200V
38 |2 |R29,R36 30K B o DI HIOW | panasonic - ECG | ERJ-3GEYJ303V
39 |1 |R32 220 ohm RES iy 220 OHM | Panasonic - ECG | ERJ-3EKF2200V
40 |2 |R33R39 15K RES ook QMAOW | panasonic - ECG | ERJ-3GEYJ153V
41 |3 |R37,R58,R60 ZERO RESQOOHMUBW. | panasonic-ECG  |ERJ-6GEYOR0OV
42 |5 |R46,R48,R50,R52,R54 560 ohm RES 200 oM V1O panasonic - ECG | ERJ-3GEYJ561V
43 |1 |Ré2 10 ohm 55&31“;(?610 OHM 1% E}:gt'jg?]'lis e |RMCF1206FT10R0
44 |1 |R67 1 ohm 553\/31'\;5)61 OHM 1% Ef:gtkrg(r)lllis e |RMCF1206FT1R00
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Appendix

Iltem | Qty Reference Value Description Manufacturer Mfr Part Number
SW SWITCH TACTILE .
45 2 |SW1,SwW2 PUSHBUTTON |SPST-NO 0.05A 12V Panasonic - ECG |EVQ-PE105K
TEST POINT PC MINI  |Keystone
46 1 |TP8 BLACK .040"D Black Electronics 5001
IC PWM TEMP SNSR | Analog Devices
47 1 (Ul TMPO5 CMOSTTL SOT23-5 Inc TMPO5ARTZ-500RL7
: F-RAM 1-Mbit (128K X |Cypress )
48 1|2 F-RAM 8) 12C interface Semiconductor FM24V10-G
PUSBM12VX4- |TVS DIODE 5.5VWM NXP
49 |1 |us TL115 12VC 6HXSON Semiconductors |~ USBM12VX4-TL,115
50 |1 |us NCPLLLTDTARK | € REG LDOADI 1A 1 oN semiconductor|NCP1117DTARKG
68QFN PSoC 5LP chip
for USB debug channel |Cypress )
51 1 us PSoC 5LP and USB-Serial Semiconductor CY8C5868LTI-LP039
interface
52 |1 |us PS0C 4200M  |68TQFP PSoC 4M Cypress CY8C4247AZI-M485
Semiconductor
IC 4BIT NON-INV
53 2 u7,u10 TXS0104ERGYR TRANSLTR 14-QFN Texas Instruments | TXS0104ERGYR
IC DIGITAL (12C)
54 1 us KXTJ2-1009 ACCELEROMETER Kionix Inc KXTJ2-1009
TRI-AXIS 12-LGA
MOSFET 2P-CH 20V .
55 1 U9 DUAL PMOS 430MA SOT-563 ON Semiconductor [INTZD3152PT1G
CRYSTAL 32.768KHZ
56 1 Y1l 32.768KHz 12.5PF SMD ECS Inc ECS-.327-12.5-39-TR
BUMPON
57 4 N/A N/A CYLINDRICAL 3M
.312X.215 BLACK
Install iumper Rectangular Connectors
58 1 1|39 acrossJ ing 1and MINI JUMPER GF Kobiconn
5 P 6.0MM CLOSE TYPE
BLACK
Install jumper Rectangular Connectors
59 1 |Ji4 across pins 3 and MINI JUMPER GF Kobiconn
. P 6.0MM CLOSE TYPE
BLACK
No load components
50MIL KEYED CONN HEADER 10 PIN
60 2 J5,J13 SMD 50MIL KEYED SMD Samtec FTSH-105-01-L-DV-K
CONN HEADER .
61 |1 |37 2 PIN HDR FEMALE 2POS .1" Sullins Connector | ppp~51) FEN-RC
Solutions
GOLD
CONN HEADER FMAL |Sullins Connector
62 1 J12 3x2 RECPT 6PS 1" DL GOLD Solutions PPPCO032LFBN-RC
CONNECTOR STACKING HEADER,
63 1 (J15 EDGE 13x2 RASPBERRY Pl Samtec Inc ESQ-113-44-G-D
CONN FEMALE 6POS |Sullins Connector
64 1 J16 6X1 RECP RA 100" R/IA GOLD Solutions PPPCO061LGBN-RC
CAP .1UF 16V .
65 2 |C7,C48 0.1 uFd CERAMIC Y5V 0402 TDK Corporation |[C1005X5R1A104K050BA
CAP CERAMIC 1.0UF .
66 1 |(C17 1.0 uFd 25V X5R 0603 10% Taiyo Yuden TMK107BJ105KA-T
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67 |9 |Rarraona RASRES: |zero ohm R 4 OHM AW panasonic - ECG | ERI-3GEYOR0OV
68 |2 |RaR4L 47K B o VIOW | b onasonic - ECG | ERI-3GEYJ472V
69 |3 |TP8,TP9,TP14 BLACK -EIS-SEE’-II: :TOE'STBﬁgS LE E&stﬁgﬂfcs 5001

0 10 |{pio e Th1atPrs | RED 65PLATED RED  |elecronics  [59%0

71 |2 |TvsLTvs2 5V 350W T2 IR 3SOWSY I pioded Inc. SD05-7

72 |3 |R7,R56,R57 ZERO s o OriM VBW | panasonic-ECG  |ERI-6GEYOR0OV
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